
      Cashbook Complete
Below are the help topics available for Cashbook Complete.    You may need to use the scroll bar to see 
entries not currently visible in the Help window.

Cashbook
Contact Management
Invoicing
Quotations
Report Writer
Reports
Setup & Administration
Time and Cost

NOTE:-    For this help file, text in Italic is only applicable if you have the relevant module selected.



Cashbook Help Contents

The help topics available for the cashbook are :-

Bank Reconciliation
Bills To Pay
Budgeting
Cash Jobs or Cash Purchases
Categories
End of Year Procedure
General Procedure
Importing
Overview
Payments Received
Recalc Button
Reports
Setup
Split Transactions



Cashbook - Overview
General Procedure          Reports          Setup          Split          Bank Rec          End of Year          Recalc          
Delete Old Data

The cashbook has been designed in such a manner that you can easily do your own book work and GST 
returns during the year.      You still need to have your accounts prepared by a qualified accountant at the 
end of the year.    The cashbook reports will give your accountant all the information required to prepare 
your accounts with minimal effort.

With a cashbook the Cash Profit is simply the Total Income less the Total Expenses.    The True profit 
takes into account depreciation, etc. and is calculated by your accountant at the end of the year.

For more information see General Procedure



Cashbook - General Procedure
Overview            Reports          Setup          Split          Bank Rec          End of Year          Recalc          Deleting a 
Line          Deleting Old Data          Cash Jobs or Cash Purchases          Searching / Sorting

The cashbook module is the financial heart of the program.    Every cheque you write and every deposit 
you make should be entered into the cashbook.    The B (Banked) column should be ticked when the item 
appears on a Bank Statement.

Items shown in Italics are only relevant for Cashbook Complete (All modules).    You can add more 
modules from the setup wizard, or else create a new cashbook with all the modules enabled.

The general procedure for adding transactions to the cashbook is:

1.    Enter the date on which the transaction occurred,    Enter the date you wrote the cheque out or the
date you banked a deposit.    If you enter a double quote (``) then the last cheque`s date will be copied 
down.

2.    Enter a Reference    You can put a cheque number, customer, or DD for Direct Debit or AP for 
Automatic Payment or VISA or any other reference information in the reference field.    If you enter a 
double quote (``) when the line above is a number, then the next reference number will be entered for 
you.

3.    Enter a Category    If the whole transaction falls into one category of income or expense, then choose
the category from the drop down list.      If one transaction is related to two or more categories, projects 
or project items then use a `split` transaction.    Simply enter `split` in the category column and the split 
entry form will open so that you can enter multiple categories, projects and project items for each 
transaction.    You can double-click on the category box to bring up the split form for an existing split 
transaction.

4.    Enter the transaction amount    Enter the transaction amount either of the income (deposits) column
or the expense (cheque`s or payments) column.

5.    Enter the GST percentage for the transaction or leave it at the default rate from the setup.
6.    Enter Notes    The Notes box is for the line you are currently on.      Press F6 from the GST Rate field 

to enter Notes box if you wish.
7.    Enter the Project Details if the transaction is related to a project    Enter the project and project 
Item that the transaction is related to and any additional notes.    Entering project details in the 
cashbook will post values into the actual column of the project costs.

8.    Invoice Details (INV, From, On) These fields display the Invoice details for the line you are currently 
on.    (You can select the Invoice here, and mark it off as paid, but it is better to do that through the 
Payments Received screen).    If you want to keep track of the amount of money you have paid to 
various creditors, you can select the creditor in the From box.

If you need to enter a transaction for an unusual amount of GST (eg. the customs department) then you 
can calculate the GST Rate as GST% = (GrossAmount x 100 / NettAmount) - 100.    If you need to enter a
transaction which is entirely GST (eg. the customs department again) then enter a GST Rate of 1E100.    
Because these are non standard GST rates you will probably need to make adjustments on the GST 
return.

After entering a transaction a new blank line will be available for the next entry, and the running total bank
balance will be updated.



Cashbook - End of Year Procedure
Reports          Bank Rec          Year 2000          Delete Old Data

At the end of the financial year you need to provide your accountant with the required financial information
for him or her to prepare a set of accounts.

If you use the invoicing module, then the following must be done before any more invoices are entered or 
paid off :-

1.    Finish all your Invoicing for the Last Financial Year    If you have any incomplete invoices then 
complete them or schedule them for the next financial year.    Make sure that all your invoicing for the 
last financial year is complete, and that you don`t later on enter any more invoices in that financial 
year.

2.    Print the Invoices Outstanding Report    Go to the the Invoices Outstanding screen, and print the 
Detail Report.

3.    Print the Bills to Pay Report    Go to the Bills to Pay screen and print the report.

When you receive your next bank statement then :-

1.    Make sure that the Cashbook is up to date    Enter all payments and deposits from your cheque 
and deposit books irrespective of whether they have been listed on your bank statement or not.

2.    Do a Bank Reconciliation. Make sure that the Bank Statement Balance in the Cash Book, and the 
Closing Balance on the Bank Statement are the same.    If not then you need to find the errors and 
correct the cashbook.    Print the Bank Reconciliation

3.    Print the Cash Book Summary    Print the Cash Book - Summary Report using the Start and Finish 
dates of the year in question

4.    Print the Detailed Cashbook Report    Print the cashbook - Detailed Report using the Start and 
Finish dates of the year in question

5.    Print the Transaction Report    Print the cashbook - Transaction Report using the Start and Finish 
dates of the year in question.

6.    Repeat for each Account    If you have used several bank accounts then repeat steps 1 to 5 for each
bank account.

7.    Enter the Next Year End Date    in the Setup Wizard under the File menu

You should now have the information required for your accountant to prepare your year end accounts.

You may also want to purge the data from the year before last (In the File, Purge menu) and then 
compact the database to speed up the backups.

Cashbook Complete uses open ended accounting, and you should not create a new cashbook at the start
of each year because all your historical data (graphs, budgets, invoices, etc.) will not be in your new 
cashbook.



Cash Book - Reports
Reports - Contents          End of Year

Cash Book - Bank Reconciliation
This report lets you do a Bank Reconciliation at the click of a button.    It Lists the Cash Book Balance, 
followed by all the unpresented cheque`s and deposits followed by what the Bank Statement Closing 
Balance should be.

Important !!    You should always do a Bank Reconciliation whenever you get a Bank Statement and 
make sure that the Closing Balance as shown on the Bank Statement is the same as the Bank Statement 
Balance as shown in the Cash Book.

Cash Book - Transaction Report
The Cash Book Transaction List is simply a print out of what you see in the Cash Book.    You can also 
make your own Transaction Report with the Report Writer.

Cash Book - Detailed Report
This report lists all the Cash Book Transactions between the dates specified, and groups them by 
Category. You can also make your own Detailed Report (Report by Category) with the Report Writer.

Cash Book - Summary
This report lists the Total for each Category of all the Transactions between the dates specified.



Cashbook Setup
Setup Wizard          Categories            Deleting a Line          Delete Old Data

For each bank account your business operates you can create a cashbook, which will record all the 
transactions made in that account.      Before using the cashbook, you need to set up the categories, 
account names, and the account Opening Balances as follows :-

1.    Check the Cashbook Categories Select Cashbook from the Top Menu, and then select Categories 
Setup.    Modify the categories to suit your business.

2.    Enter your Account Numbers    Select Cashbook from the Top Menu, and then select Accounts 
Setup.    Then enter your account type and number.    For example if you have a cheque account, a 
savings account and a term deposit account, enter names such as Cheque 060169 0090888 01,    
Savings 060169 0090888 25,    Term Deposit,    etc.

3.    Enter the opening balance    Select a Bank Statement from which you wish to start (preferably the 
start of the financial year), and enter the opening balance.

4.    Enter all the Items from your Bank Statements    Open the cashbook, and enter all the items from 
the first selected Bank Statement.

5.    Do a Bank Rec    Do a Bank Reconciliation after entering each Bank Statement
6.    Repeat 4 and 5    Repeat steps 4 and 5 for all subsequent Bank Statements which have not been 

entered.
7.    Change the Dates    Change the dates for each cheque item in the cash book to be the date on which

the cheque was written rather than the date on which it was presented.    (You can leave this step and 
step 8 out if you wish, but it would mean that you always enter the data from your bank statements, 
rather than from your cheque and deposit books.    Although it is a bit easier,    the disadvantage of this 
method is that you won`t know the amount of money which you have on hand.    ie. The Cash Book 
Balance.)

8.    Enter all the Items from your cheque / deposit Books    Enter all the items in your cheque book 
and deposit book which have been made after your last bank statement.

Your cashbook is now set up and ready to use.

By entering your cheque and deposit information from your cheque and deposit books on a regular basis, 
you will always know how much money you have available by looking at your cashbook balance.



Cashbook Categories
Cashbook Setup          Deleting a Category          Balance Sheet Categories

The cashbook categories need to be set up before using the cashbook.    It is important to set up the 
categories in such a manner that they give you useful reports.      The cashbook is initially set up with 
default categories, but you can either :-

1.    Add a new category at the bottom of the list.
2.    Delete an existing category by placing the cursor on it and then selecting Delete Line from the Edit 

menu.
3.    Rename an existing category by simply over-typing it.

Income categories are for your sales / income.    Expenses are for your costs / expenses.    Balance sheet 
items are those items where although there is a transaction of some nature, it does not directly affect your
cash profit.    Click on the link above for more information.

If you put a category in the Balance Sheet section when it should be in the Expense section or vice versa,
then you can always move it later.    A lot of cash books do not have a Balance Sheet section, so you 
could simply put everything under either the Income or Expense sections.    The cashbook would still 
calculate the GST correctly.

Some accountants may request that you use specific codes for each category so that they can simplify 
the preparation of the year end accounts.    To do that simply prefix each category with the corresponding 
code (eg. 470 Telephone).

If you want to use Sub Categories, you can put a : between the main category and the sub category.    For
example you could enter the categories Motor Vehicle:Joe, Motor Vehicle:Fred, and Motor Vehicle:Mark.   
Most reports will show them seperatley, but the Sub Category Report in the Report Writer, will combine 
these into one category.



Cashbook Categories - UK and Ireland
Cashbook Setup          Deleting a Category          Balance Sheet Categories

The cashbook categories need to be set up before using the cashbook.    It is important to set up the 
categories in such a manner that they give you useful reports.      The cashbook is initially set up with 
default categories, but you can either :-

1.    Add a new category at the bottom of the list.
2.    Delete an existing category by placing the cursor on it and then selecting Delete Line from the Edit 

menu.
3.    Rename an existing category by simply over-typing it.

Income categories are for your sales / income.    Expenses are for your costs / expenses.    Balance sheet 
items are those items where although there is a transaction of some nature, it does not directly affect your
cash profit.

If you put a category in the Balance Sheet section when it should be in the Expense section or vice versa,
then you can always move it later.    A lot of cash books do not have a Balance Sheet section, so you 
could simply put everything under either the Income or Expense sections.    The cashbook would still 
calculate the GST correctly.

Some accountants may request that you use specific codes for each category so that they can simplify 
the preparation of the year end accounts.    To do that simply prefix each category with the corresponding 
code (eg. 470 Telephone).

The Expense and Balance Sheet columns have a tick box labled `Ex` to indicate categories which are 
Exempt from VAT such as wages, PAYE, National Insurance contributions, drawings, loans, gifts, 
charitable donations, insurance claims, MOT certificates, motor vehicle licence duty, and local authority 
rates.    For more information see your accountant or HMCE.

If you want to use Sub Categories, you can put a : between the main category and the sub category.    For
example you could enter the categories Motor Vehicle:Joe, Motor Vehicle:Fred, and Motor Vehicle:Mark.   
Most reports will show them seperatley, but the Sub Category Report in the Report Writer, will combine 
these into one category.



Cashbook Categories - Balance sheet Items
Cashbook Categories

Income and Expenses are easy to understand, but balance sheet items are a bit harder.      Balance sheet 
items are those items where although there is a transaction of some nature, it does not directly affect your
cash profit.      For example :-

1.    Transfer    If you transfer money from one bank account to another, that does not affect your cash 
profit.

2.    Assets    If you purchase an asset, the asset will affect your bank balance, but not your cash profit.    
An allowance for depreciation will be made by your accountant at the end of the year.

3.    Drawings    If you take drawings (Salary) out of the company, you are taking some of the profit out of 
the company, but you are not affecting the profit you make.

4.    GST Paid to the Tax Department    You will have been collecting GST on behalf of your 
Country/State.    The GST payments you make to them are therefore not an expense.

If you put a category in the Balance Sheet section when it should be in the Expense section or vice versa,
then you can always move it later.    A lot of cash books do not have a Balance Sheet section, so you 
could simplify matters by putting everything under either the Income or Expense sections.    The cashbook
would still calculate the GST correctly.



Cashbook - Recalc Button

The `Recalc` button recalculates the bank balances if for some reason the database has been corrupted 
(eg. The power to the computer went off while entering a transaction), or if Dates have been changed, 
etc.



Split Transactions
Deleting a Line

Split transactions are used to show a series of costs as one entry in the cashbook, for example a VISA 
bill. To create a new split transaction, select Split in the category box.    To open an existing Split, either 
double click where it says Split in the Category column, or else click the Split button on the toolbar.    
Please note that the Split button is only enabled when you are on a split, and cannot be used to create a 
split.

Enter each item included in the split transaction ( for example each item on a VISA bill).    When the form 
is closed, only the totals will be shown in the cashbook line. The information for each item in the split 
transaction is still stored separately. To view (zoom into) the details of a split transaction, double click on 
the split category, or click the Split button.

Split Transactions can also be used to split items such as your Motor Vehicle expenses between business
and private.    For example if you allocate 75 % of your motor vehicle use to the business, and you 
purchase $ 40 of petrol, then you could enter a split entry which has $ 30 as a business expense and $ 10
for drawings (Private use).



Reconciling The Cashbook With Bank Statements
Reports          End of Year

When you get a bank statement, first check that the opening balance is the same as the current bank 
balance as shown by the cashbook (in the bank statement box).

Then simply tick each item on the statement and the cashbook as a pair.    If there is an item such as bank
fees, interest, or an automatic payment on the bank statement which is not in the cashbook, then enter it.  
Check that the amounts are correct as you tick each item.    When you have ticked all the items, the 
cashbook balance should equal the bank statement closing balance.

Important :- If the balances are not equal, then go through all the items on the bank statement and find 
where the error is.    If you do not find where the error is, then it will progressively get harder and harder to
find where the error is, and you will make life very difficult for yourself or your accountant at the end of the
year.

Important :- Print out the Bank Reconciliation after each bank statement, or if you get several bank 
statements a month, print it out at the end of each month.



Cashbook - Shift Category

If for example you want to change a cashbook category from `Expense` to `Balance Sheet`, then with the 
arrow keys move down to the category you want to change, and select `Balance Sheet` from the Combo 
Box.



Payments Received
Deleting a Line

The Payments Received screen enables you to enter all of your bank deposits quickly and easily.    The 
Payments Received are automatically posted into the Cashbook and Invoice Payments (To mark them off 
as Paid).    Although you can enter Payments Received directly into the cashbook if you wish (with the 
same end results), it is easier to enter them through this screen.    If you have a lot of payments, you may 
want to print out the Cheque Listing and attach it to your deposit slip.

To enter payments received :

1.    Select the Appropriate Account    From the Account drop down box, select the correct account for 
which the payments should appear in the cashbook.

2.    Check the Date    Either accept the default date, or override the date by typing in your own date.
3.    Select a Company    From the Company drop down box, choose the company for which the payment 

is from.    If you know the invoice number you can skip this step.
4.    Select an Invoice    (Cashbook Complete only)    The INV drop down box will show you a list of all 

outstanding invoices for the company selected.    Simply select the invoice that you have received 
payment for.    If you have received one cheque for several invoices then enter each invoice on a 
separate line.    They will be recombined in the cheque listing if you use it.

5.    Select a Category    From the category drop down box select the appropriate category for the 
payment.    The category will automatically appear the next time you choose the company currently 
selected.

6.    Enter Bank and Branch    You can enter Bank and Branch details if you need to print out a cheque 
listing.    As with categories, these will also automatically appear next time you choose the company 
currently selected.

7.    Enter Notes    If you wish, you can enter miscellaneous notes into this text box.
8.    Enter the Amount    The amount defaults to the invoices outstanding amount.    It can be overridden 

by typing in your own amount.    If you are paying too much, or too little, Cashbook Complete will ask 
you if you are sure you want to process that amount.

9.    Repeat Steps 2 to 8    Repeat steps 2 to 8 for all your payments received.
10. Print out a cheque listing    If you have lots of cheque`s to deposit, you may want to print out the 

cheque`s listing to attach to your deposit slip.    On the cheque listing, if there are several consecutive 
lines with the same company name (ie. one cheque for several invoicies), they will be combined into 
one line on the printout.

11. Post to Cashbook    Once you have entered your payments received, simply click on the Post to 
Cashbook button, and all transactions listed will be posted into the cashbook.    The amount 
outstanding for each invoice will be updated, and the status will be changed to Paid if appropriate.    
When the transactions have been posted, the cashbook screen will load.    If more than one payment 
was received, then they will be put into the cashbook as a split transaction.



Bills To Pay - General Procedure
Deleting a Line          Retentions / Part Payments

The Bills To Pay screen lets you keep track of the bills you have to pay, and lets you post them into the 
Cashbook in one easy step.    Although you can enter bills you have paid directly into the cashbook if you 
wish (with the same end results), it is easier to enter them through this screen.

The general procedure for entering a new bill is :

1.    Select the Appropriate Account    From the Account drop down box, select the correct account for 
which the bills should appear in the cashbook.

2.    Enter the Date the Bill is Due    Type in the date in which the bill is due.
3.    Enter the Invoice Date    Type in the invoice date.    The Invoice date is important if you calculate GST 

on an Invoice or Accrual Basis.
4.    Enter a Company    From the drop down box, choose the company whom the bill is from.    If the 

company does not exist, then you will be prompted to add the new company.
5.    Select a Category    From the category drop down box select the appropriate category for the bill (This

will be used for the Cashbook later on).
6.    Enter Notes    If you wish, you can enter miscellaneous notes into this text box.
7.    Enter the Amount Type in the amount you were billed for.

The general procedure for paying bills is :

1.    Print out the Bills To Pay (Optional)    If you need to get someone else to approve the bills to pay then 
you can print it out and give it to that person first.

2.    Write out the Cheque`s    For each bill you want to pay, Tick its Pay box, and write out a cheque for it.
3.    Print out the Envelopes (Optional)    Tick the Env box for the bills you want an envelope printed and 

click on the Envelope Print Button.    To print envelopes your printer must have an envelope feeder
4.    Post to the Cashbook    When you have written out all the cheque`s and printed out all the envelopes 

you want, press the Post to Cashbook button to transfer these transactions to the Cashbook.

The cashbook balance provides you with a quick check of how much money you have in the bank.

A customisable version of the report is available in the Report Writer.



Bills To Pay - Retentions / Part Payments

If you only want to pay part of a bill because the work is not complete, or is faulty, then simply enter two 
records, one for the amount you want to pay now, and the other for a date in the future with the remaining 
amount.



Cash Jobs or Cash Purchases

Cash Job

If you get paid cash for a job you have done, and you don`t bank the money, then simply enter a double 
transaction into the cashbook as shown below :-

The Income and Expense amounts cancel each other out, so the bank balance is not effected.    The 
business received money from a sale and paid it out to you in the form of drawings / salary.    The GST is 
still calculated correctly, and the sale is recorded in the cashbook.    Please Tick the B column for these 
lines, because they have effectively both been banked.

Cash Purchase

If you purchase an item for your company out of your own money, then you can simply enter it as a 
double transaction as shown below :-

The Income and Expense amounts cancel each other out, so the bank balance is not effected.    The GST 
is still calculated correctly, and the purchase is recorded in the cashbook.    To understand this transaction,
remember that it is from the point of view of the business!      The business had a parking expense, and 
paid for it by receiving the money from you.    Please Tick the B column for these lines, because they have
effectively both been banked.

It is not recommended to put these double transactions into a Split Transaction, because the Nett Amount 
in the main part of the cashbook can look rather odd (even though it is right).



Cashbook - Importing

You can import cashbook data from MS Money or Quicken, or any other program which supports the .QIF
format.    Please note that due to slight changes in the qif file format, your qif file may not import. 

To import the data :-

1.    Export the data to a QIF file from MS Money or Quicken    The import routine accepts either loose QIF 
or strict QIF.

2.    Back up your data    Go into the File menu, and select Backup before trying to import.
3.    Import the data    Select Import Cashbook from the Cashbook menu.    If GST is enabled, then check 

that the GST rate is correct.    Locate the QIF file name, and press the Import button.    The data will be 
placed into a new account if it doesnt already exist.

4    Check the Category Types    Once the data has been imported, please check the categories, and shift 
them to the appropriate type (Income, Expense or Balance Sheet).    You can shift categories by 
selecting Categories Setup from the Cashbook menu, and then select Shift Category.

5.    Check the Category Names    Check that the Category names are correct.    Some of them may have 
been truncated.

6.    Check the Account Details    Check that the Account details are correct (Select Account Setup from 
the Cashbook menu).    You may want to delete the old account first.    (View help from the Accounts 
screen).    You can enter the opening balance and do a full bank rec if you want to.

7.    If your Import was Unsuccesful    If your accounts, account balances, etc. do not look correct, then 
revert back to your original data by going into the File menu, and selecting Restore.

MS Money and Quicken are trademarks of Microsoft and Intuit respectively.



Budgeting

You can set up income and expense budgets for each month, to track your progress through the year.    
For your convenience the actuals are shown in yellow below the budgets.

The easiest way to set up your budgets is to start off by printing out last years actuals (click on left arrow 
to go to previous year) and then decide what you want to aim for.    You can either enter each monthly 
budget, or if it is the same for each month, you can enter the annual amount into the total column.

The Recalc button recalculates all the actuals from the cashbook data.



Budgeting Setup

Here you can select the bank accounts you want to include in the calculation of the budget actuals.

For example, you might not want to include your Term Deposit account in the calculation of the actuals, in 
which case you would set it to No.



Quotations Help Contents

The help topics available for Quotations are :-

General Procedure
Overview
Word Processors



Quotations - Overview
General Procedure          Report Writer          Word Processors          Delete          Delete a Line          Add          
Delete Old Data

The Quotations module lets you make professional quotes quickly.    If you have entered your products 
and services, then you can quickly enter the clients name, enter the quantities and other items into the 
Calculation Sheet, open the word processor, and hey presto, you have the basic framework of your letter 
done for you too.

Word Processors
If you have Windows 3.11 then Microsoft Write is used as a word processor.    If you have Windows 95, 
then Microsoft Wordpad is used as the word processor, or if you have Microsoft Word installed, then you 
can click on the large W to use Microsoft Word.

Margin
This is the profit which you would make on the job and is calculated as the total difference of the sell price
less the cost price for all products / services listed on the calculation sheet.



Quotations - General Procedure
Overview          Report Writer          Word Processors            Delete          Delete a Line          Add          Delete Old
DataCreating an Invoice from a Quote

1.    Select the client from the list    Open a New quotation screen, and select a client from the list.    If 
the client has not been entered yet then enter the clients details first.    You can change the address for
this quotation if you wish.

2.    Enter a Description for the Quotation    Enter a meaningful description.    It will be used in many 
places such as lookups, reports and your letter.

3.    Enter the Quote By and Quote For Items    These will be used in the letter and for future reference.
4.    Enter the Items in the Calculation Sheet    These items will determine the value of the quote and will

show you the Margin (Profit) of the job.    You can use the small binoculars  to select a product or 
service or employees time if you have already set these up.

5.    Enter the Default Text (If required)    If you havent entered the default text  then enter it first.    
The default text is used for each new quote you make to define the text before and after the Item List.

6.    Open the Word Processor    Click on either  or 

 to make a new word processor document with Wordpad (or Write if Windows 3.11) or Word.    Answer 
whether you want the details listed or whether you want to insert your own price details.    You will see the 
initial version of the quotation be entered automatically.      Note: You must have a current printer in the 
Windows Control Panel for these buttons to work correctly.
7.    Edit the Quotation Document and Print it    Edit the document and print it as required.
8.    Save the Document    When you exit the Word Processor be sure to save it.    You will now see that 

the word processor icon has changed to blue  to let you know next time you open the quote which 
icon was used for the word processing.



Quotations - Word Processors

If you have Windows 3.11 then Microsoft Write is used as a word processor.    If you have Windows 95, 
then Microsoft Wordpad is used as the word processor, or if you have Microsoft Word installed, then you 
can click on the large W to use Microsoft Word.

Compatibility
Microsoft Word 6.0 (for Windows 3.11) and Word 7.0 (for Windows 95) and Microsoft Wordpad (for 
Windows 95) are all compatible with each other, so it is best to use one of these three products.    
Wordpad comes standard with Windows 95 and is a great little word processor.    Word 8.0 (part of Office 
97) uses a different file format which means that you cannot view it with Wordpad afterwards.

Speed
Wordpad and Microsoft Write open quickly, so for convenience you may wish to stick to using them only.

Buttons

    Create quote using ``Wordpad`` or ``Write``

    Create quote using ``Word``

The buttons turn blue if they have been used before as shown below.

    Re-open quote using ``Wordpad`` or ``Write``

    Re-open quote using ``Word``

Microsoft Word Path
If you have Microsoft Word, and the Large W comes up with the error ``Couldn't start Word for Windows`` 
then either you dont have Word installed on your computer, or if it is then you need to setup the correct 
path in the Setup Wizard.    Go into the Setup Wizard and click Next until you get to the Setup Time & 
Cost, Quotes screen.    Make sure that the path contained in the MS Word Location for Quotes is correct.   
If it isnt then use the browse button to find the correct path.



Time and Cost Help Contents

The help topics available for Time and Cost are :-

Employees
Projects / Jobs
Timesheets
Expenses
Products / Services
Stock Take



Projects / Jobs
Timesheets          Expenses          Delete          Delete a Line          Add          Creating an Invoice from 
Timesheets and Expenses

If you have a project / job for which you want to track the costs and income, then you can set one up here.
If for a new project, you select the quote for that project, then a lot of the initial setup will be done for you.

Budgets
You can set up a budget for a project, and then allocate costs against those budgets as the project 
progresses.

Actual Values
The Actual values are calculated from the Time Sheets, Expenses and Cash Book screens.    You can see
how the actual cost is made up by clicking on the Magnifying glass for that item.

Income Received
The Income Received is calculated from the Cash Book screens when you allocate a income against a 
project.

Recalc Button
You can press the Recalc button to recalculate the Actual Values and Income Received.    This should not 
normally be necessary but has been included just in case the database gets corrupted.    (For example if 
the power goes off while you are entering data)

Reports
There are two standard types of report available, but you can configure your own reports using the Report
Writer.



Employees
Timesheets          Expenses          Contacts

This page records your employee information.    If you want to set up different access rights for different 
employees and the security check boxes and logon fields are disabled then you must select security in 
the Setup Wizard first.

The Wage Rate is optional, and is there to keep a record of what their wage rate is.

The Cost Rate is normally the Wage Rate plus about 20 % to 30 %.    This is to take into account the fact 
that they also have paid holidays and non chargeable time.    The Cost Rate is used together with the time
sheet information to calculate project costs.

The Charge Rate is the amount that you charge your customers.    It is used in the invoicing module to 
create invoices from time sheets.

If you dont use Time and a Half, or Double Time rate then leave them blank.

All other fields are optional.



Time Sheets
Employees          Projects / Jobs          Expenses          Deleting a Line          Deleting Old Data          Creating an
Invoice from Timesheets

The Time Sheets screen is to :-

1.    Keep track of the Hours which your employees have worked    You can keep track of your 
employees time and make reports on their times using the Report Writer.

2.    Keep track of your Project Expenses    You can allocate time against various project items to 
determine the project costs, and can also make reports on the time spent on each project using the 
Projects Detailed Report or the Report Writer.

3.    Allow easy Invoicing if you do a Project on an Hourly Rate    If you do some work on an hourly 
rate, then you can import those times into an invoice for that customer.    For those items to be invoiced
be sure to set the Invoice column to `Yes - To be Invoiced`.    After the invoice has been generated, the 
Invoiced column will read `Done - Has Been Invoiced`.

Hourly Rates Stored
When you enter a Time Sheet item, the employees current (cost) hourly rates are stored as well for that 
line item.    This is to make sure that the calculations for old data does not change when you change the 
employees hourly rate.    You can view and edit the hourly rates if you have the `Time and Cost` privileges
by scrolling to the right.



Expenses
Employees          Projects / Jobs          Time Sheets          Deleting a Line            Deleting Old Data          
Creating an Invoice from Expenses

The Expense screen is to :-

1.    Keep track of the your Employees Expenses    You can keep track of your employees expenses.
2.    Keep track of your Project Expenses    You can allocate expenses against various project items to 

determine the project costs, and can also make reports on the expenses for each project using the 
Projects Detailed Report or the Report Writer.

3.    Allow easy Invoicing if you do a Project on a Hourly Rate Plus Expenses Basis    If you do some 
work on an hourly rate plus expenses, then you can import those times into an invoice for that 
customer.    For those items to be invoiced be sure to set the Invoice column to `Yes - To be Invoiced`.   
After the invoice has been generated, the Invoiced column will read `Done - Has Been Invoiced`.



Products / Services
Quotations          Invoicing          Deleting a Line

This screen lets you configure your Products and Services, and see a summary of your sales history.    
Use the horizontal scroll bar to see more fields on the right hand side.    The fields are as follows :-

1.    Group    If you want to group your products and services, you can add a group name here.    If you are
entering lots of items with the same group name, then enter that group name in the default field at the 
top of the screen.    If you don`t want to use groups then leave this field blank.

2.    Code    This is the Product / Service code. If you don`t want to use product codes then leave this field 
blank.    The sales history in the last 4 columns is only calculated for items with a code.

3.    Description    This is a description of the item and is a compulsory field.
4.    Units    Enter the units for the product or service.    Eg.    Hours, kms, miles, m, m², m³, Sheets, Box, 

Box 20, Box 50.    If you enter m2 or m3 the units will change to m² or m³.
5.    Cost Price    This is the price you purchase the goods for, or the cost of the services to you.    The 

sales tax setup screen in the setup wizard specifies whether the prices include or exclude GST.
6.    Sell Price    This is the price you sell the product or service for.    The sales tax setup screen in the 

setup wizard specifies whether the prices include or exclude GST.
7.    Type    There are 4 types.    `Inventory` means a product for which you want to keep track of stock 

levels. `Non Inventory` means a product for which you do not want to keep track of stock levels (ie. 
only want to know the pricing information).    If you have upgraded from an older version of Cashbook 
Complete the Type is set to `-` which means `Unassigned`.    Please change these to the corrrect type.

8.    On Hand    This is the quantity you have in stock at the moment, and is only available for products 
(not services).

9.    Notes    Enter any further notes about the product such as the supplier, quantity on order, etc.
10. Sales YTD    This is the sales of this item for the Year To Date.    The sales tax setup screen in the 

setup wizard specifies whether the prices include or exclude GST.
11. Qty YTD    This is the sales quantity (in units) of the item for the Year To Date.
12. Sales LYR    This is the sales of this item for Last Year.    The sales tax setup screen in the setup 

wizard specifies whether the prices include or exclude GST.
13. Qty LYR    This is the sales quantity (in units) of the item for Last Year.

This screen is sorted by group and then by code.    You can change the sort order by clicking on the field 
you want to sort, and then selecting Sort A-Z from the Edit menu.

New products or services are always added at the end.    The next time you open this screen, the records 
will be sorted.

Importing Products and Services
To import Products or Services from a spreadsheet, simply organize the spreadsheet into six columns in 
the same order as the cashbook screen, and then copy and paste the rows in.    (ie.    highlight the rows in 
the spreadsheet, select Copy, highlight the new blank record at the end of the Products / Services screen,
and select Paste).    It is recommended that you can initially just cut and paste one line to test the import 
procedure.    Before doing the bulk import, it is recommended that you do a backup, just in case the import
does not go the way you want it to.



Stock Take
Report Writer

Simply print out the Inventory Report in the Report Writer, and write the actuals next to the theoretical 
amount On Hand.    When you have finished, adjust the values in the Products an Services screen.    If 
you want to do a blind stock take, then remove the On Hand column before printing the report out.



REPORT WRITER Help Contents

The help topics available for the Report Writer are :-

General Procedure
Formatting Columns
Headers / Grouping
Spreadsheets
Where Conditions
Wizard



Report Writer - General Procedure
Formatting Columns          Headers          Spreadsheets          Deleting a Line          Inserting a Line          Page 
Setup          Where Conditions

The Report Writer lets you configure your own reports and save the templates for future use.

Each row in the report writer screen sets up a column in the report.

The General Procedure for making your report are as follows :-

1.    Give your Report a Name  .      This name will printed at the top of the report, and will be used to 
store the report template for future use

2.    Select the Fields you want to display in the order in which you want them to appear across the
page.    Put fields which you want as headers first.

3.    Select the Fields to be displayed as a Heading    If you want fields to be displayed as a 
heading or sub heading then Check the `Header` Check Box for that field.

4.    Preview the Report to check that the layout is as you want it, and make alterations to the 
Widths and Alignment.

5.    Page Setup Press the `Page Setup` button to set up the Margins and select either Landscape 
or Portrait to orient your Pages.

6.    Select Totals (Sum) for numeric fields if you want them to have Totals at the end of the report 
or Group.

7.    Select Sorting for the fields that you want sorted.    You can either sort Ascending or 
Descending.

8.    Select the WHERE Conditions if you only want to display information that meets certain 
criteria.    You can select =, >, >=, Like, Between, etc.      With the `Like` keyword, you can do 
comparisons with wild cards such as * and ?.    For example Like Acc* will select Acclaim,    
Accent,    Accroplolis, etc.    With the `Between` keyword, you can select a range between two 
values.    This is most commonly used for dates. More info here

9.    Preview the Report and make alterations as required



Report Writer - Formatting Columns

Column Widths

The Column Widths are adjusted by altering the Width Box next to the field selected.    The width is 
roughly the number of characters that will be displayed.    It is not the actual number of characters 
because different characters have different widths.

Column Alignment

Each column can be either Left, Center or Right aligned.    Text is usually left aligned, numbers are usually
right aligned, and Dates are usually center aligned.

Inserting a Blank Column to make a Gap

To insert a Blank Column Select <Blank> from the fields list and adjust width of the Gap

Hiding a Column

To hide a column simply make set its width to zero.    This may be when for example you want to have the 
report meet certain criteria, but dont want to display the information.



Report Writer - Headers / Grouping

In a report you can have headings and group items together.    If you want to use one level of headers / 
grouping then it must be on the first field.    If you want two levels of headings / grouping then it must be 
on the first two fields.    You can have sub totals at the end of a group if you select Sum for that field.



Reports Writer - Spreadsheets

      You can display the report data in a simple spreadsheet layout by clicking on this Spreadsheet 
button.

To copy the data into Excel click on the grey square on the top left hand part of the spreadsheet.    This 
will select all the data in the spreadsheet.    Then press CNTL C.    This will copy the data onto the 
clipboard.    Then open Excel and press CNTL V to paste the clipboard onto the spreadsheet.



Report Writer - Deleting a Line

    Click on this icon to delete a line in the Report Writer



Report Writer - Inserting a Line

    Click on this icon to insert a line in the Report Writer



Report Writer - Page Setup

      Click on this icon to adjust the margins, paper size, etc.



Report Writer - Where Conditions

There are many different operators that can be used to filter your data. Each one is explained below.

Blank

Having a blank where condition means that nothing will be filtered. All information for that column will be 
displayed.

=

The equals operator means show all records that are exactly equal to the criteria entered. The following 
example would display all contacts whose name is exactly equal to Nuku Productions. Note that the 
equals operator is case sensitive, ie. if you specified Nuku Productions as the criteria, then Nuku 
Productions would not be found.

 

>

This is the greater than operator. It filters records that are greater than the criteria entered. The example 
below would display all selling price amounts which are greater than five.

<

The less than operator works the opposite way. It filters all records that are less than the criteria entered. 
The following example would display all selling price amounts which are less than five.

>=

The greater than or equal to operator shows all records that are greater than, or equal to the criteria 
entered. The example below would display all selling price amounts which are greater than, or equal to 
five.

<=

The less than or equal to operator shows all records that are less than, or equal to the criteria entered. 
The following example would display all selling price amounts which are less than, or equal to five.

<>

This is the does not equals operator. It shows all records that do not equal the criteria entered. The 
example below would display all contacts that are not called Nuku Productions (case sensitive).

Like



The like operator searches for values that are like the criteria you specify. The like operator is not case 
sensitive. Using a wildcard (*) will find a range of values (eg. sm* would search for contacts whose name 
begins with sm, sM, Ms, or SM). The following example would display all contacts whose name begins 
with nuku.

Between

The between operator shows all records that are between the criteria entered. The example below would 
display all records that have a date between 1/1/98 and 31/1/98.



Report Writer Wizard - Report Name

The report writer wizard lets you set up a report as easily as possible.    It is easier than the normal report 
writer, but once you have used the wizard a few times you will probably be able to create reports quicker 
with the normal report writer.

Each report is saved so that it can be re-used at a later date.    Please enter a report name which will help 
you look it up again at a later date.



Report Writer Wizard - Data Source

Please select where you want the data to come from.

Some items have different levels of detail.    For example, Projects has three levels of detail.    The first 
level gives just the basic information about each project, the second level lists the costs for each job cost 
category, and the third level lists each item in each job cost category.



Report Writer Wizard - Grouping / Headings

Please select the level of grouping required.

Click on the Radio Buttons to select your choice.    The picture below the Radio Buttons will show you the 
layout you will get for each level of grouping.

If you are not sure, then start off with no grouping.



Report Writer Wizard - Column Headings

Please select the data you want displayed in each column of the report.

If you have selected Grouping, then please select the data to display for the Group Headings first.    After 
seeing the choices, you may want to change the level of grouping by clicking on the Back button.

When you select an item, then sample data is inserted so that you can see whether you are on the right 
track or not.    Please note that the sample data is to give you an indication only of what the final report will
contain.



Report Writer Wizard - Complete

There is no help for this screen.



Invoicing Help Contents

The help topics available for Invoicing are :-

Back Orders
Batch Invoicing
Batch Statements
Column Options
Credit Notes / Adjustment Notes
Editing / Deleting a Printed Invoice
Editing / Deleting Payments
Footer Text
General Procedure
Overview
Outstanding
Payments
Payments Received
Setup Letterhead
Setup Wizard
Statements



Invoicing - Overview
General Procedure          Payments          Delete / Edit          Delete a Line          Add          Credit Notes          
Delete Old DataBatch Invoicing

The Invoicing part lets you Bill your clients with three different invoice styles.

You can import your data for the invoice from a Quote, or from the Time and Cost Module.

All new Invoices have a default Terms message which can be edited if required.

You can enter Notes which will be printed at the bottom of the Invoice if you wish.

You can enter part payments, or full payments in the payments panel.    A report can be printed of all the 
invoices outstanding.

The Invoices have three different states.    They are    :-

`Incomplete` when you create a new Invoice
`Outstanding` after you have printed the Invoice
`Paid` when you have been paid (to within a dollar)

Only `Incomplete` Invoices can be edited.    Only `Outstanding` Invoices can have an entry made in the 
Paid Panel.    If you have made a mistake, you can Click on the `Pencil Eraser` icon to move the status 
back a step.



Invoicing - General Procedure
Overview          Payments          Delete a Line          Add          Credit Notes and Bad Debts          Delete Old 
Data          Editing / Deleting a Printed Invoice          Editing / Deleting Payments          Batch Invoicing          
Invoice Column Options          Back Orders

1.    Select the Client from the List    Select a client from the list.    If the client has not been entered yet 
then you will be prompted if you want to add them to the list.    You can change the address for this 
invoice if you wish.

2.    Select the Invoice Column Options you want for this Invoice    You can customise your invoicing 
layout to display columns for Discounts, Product Codes, etc.    Try selecting different options and watch
how the invoice layout changes.

3.    Enter the Clients Order Number    if they have one
4.    Enter who or what the work was done for    You can enter several lines of data here if you wish by 

zooming in
5.    Enter the descriptions and amounts for each line item    If you have entered products and services

and / or employee hourly rates then you can select them with the 
6.    Page Setup    To alter the page setup for Invoice printouts, select Print Setup from the File menu.
7.    Print the Invoice Out    If todays date is different to the Invoice Date, you will be asked if you want to 

change the Invoice date.    The status will change to Outstanding.    If you want to change the Status to 
Outstanding without printing the invoice, then select Print from the File menu, and then click Cancel.

8.    Envelopes    Invoices and Statements are designed to work with window envelopes to save you time. 
You may need to adjust your letterhead setup to position the address correctly in the window.    If you 
do not want to use window envelopes, you can print out a normal envelope.

You can enter notes or miscellaneous information about a job by typing in a new line, and then deleting 
the Quantity, Units and Price information.

If you have already done a quote for the client, then you can import that quote to make a new invoice, or if
you are doing a job on an hourly rate plus expenses, then import the data from the client you want.



Invoicing - Payments
Deleting a Line          Payments Received          Editing / Deleting Payments

There are three ways of paying an invoice off :-

1.    In the Payments Received screen    This screen lets you enter payments for many invoices in one 
data entry screen, and is the recommended way of entering payments you have received.

2.    In the Cashbook    Make a new transaction (or a Split if you want several deposits to appear in one 
transaction) and enter the Invoice Number in the Line Details at the bottom of the screen.

3.    In the Invoice    Simply enter the date and amount of each payment a client makes against an Invoice
in the Payments section of the invoice.    If you do not enter a date then todays date will automatically 
be entered by default.    If you double-click in the amount column of a new payment record then the 
software will automatically insert the outstanding amount and today`s date.



Invoicing - Deleting and Editing
Delete Old Data

Editing
Only `Incomplete` Invoices can be edited    If you have made a mistake, you can click on the `Pencil 
Eraser` to move the status back a step    (Admin privilege required).    You can then edit it.

Deleting
Only `Incomplete` Invoices can be deleted with the X ! button.    If you want to delete an `Outstanding` 
Invoice, then click on the `Pencil Eraser` to move the status back a step (Admin privilege required).    You 
can then delete it.



Invoicing - Editing / Deleting a Payment
Delete a Line

Invoice payments are usually linked to the cashbook, so any corrections to these payments need to be 
made in the cashbook.    Simply look at the date and the amount of the payment, and find the 
corresponding transaction in the cashbook.    The transaction may be in a Split.    Check that the invoice 
number is the same, and then make the changes you want to make as follows :-

Deleting
To delete the invoice payment, you can either delete the whole transaction from the cashbook (see Delete
a Line above), or remove the link to the invoice payment (see below).

Editing
To modify the amount of the payment, you need to first remove the link to the invoice (see below), change
the Invoice amount, and then add the link to the invoice back in again.

Removing a Link from the Cashbook to an Invoice Payment
First click anywhere on the relevant transaction in the cashbook.    In the Line Details at the bottom of the 
screen, check that the invoice number in the INV box is the correct invoice number.    Delete the invoice 
number from the INV box.

Editing / Deleting if not linked to cashbook
If the invoice status is Paid, then first click on the Pencil Eraser button to rewind the status of the invoice 
back to Outstanding.    You can then modify the amount, or date, or can delete the whole payment (see 
Delete a Line above).



Credit Notes / Adjustment Notes

If you accidentally over-invoice a client, or they return something and want a credit for it, or have a bad 
debt, then you can issue a Credit Note (or Adjustment Note in Australia).

A Credit Note is made by making an Invoice with negative `Quantities` or `Unit Prices` on the Invoice.

When you print it, you will be asked the invoice number to which it relates, and a credit will be made 
against that invoice.    A Credit Note will be printed instead of an Invoice.



Letter Head

You can customise your letterhead by selecting Letterhead Setup from the Invoicing menu.    The 
letterhead setup screen has five objects which you can customize.    They are :-

1.    Company    Displays your company`s name.    You can edit it where it is displayed.
2.    Graphic    Displays your company`s logo.    You can Insert your own logo
3.    Address    Displays your company`s Address, Phone, etc.    It can edit it where it is displayed.
4.    Line    Displays a line.    You can adjust the thickness (height) and the distance from the top.
5.    Header    This is the headers overall size (ie. The height of the area to set aside for the letterhead).

The company name, company logo (graphic) and address can be moved around on the letterhead, and 
can also have their size adjusted.

A small preview of the header is shown at the top of the screen.    This preview does not show the page 
margins, and light grey borders are shown around the objects so that you can see where they are.    To 
see the real preview, click on the Preview button.

If you have your own letterhead which you want to use, you can make all the objects invisible, and adjust 
the Header Height to suit your letterhead.



Inserting Your Company`s Logo

Inserting your logo is simply a cut and paste from Microsoft Paint, but often needs some preparation, and 
needs to be done by someone with reasonably good computer skills.

To insert your logo, you need to make a bitmap (.BMP) file with your logo in it first.    You can create 
a .BMP file either by :-

1.    Converting from another format    If you have your logo on disk then ask your graphics designer to 
save it as a .BMP file.

2.    Scanning it in    Your logo can be scanned in from your letterhead.    This can often be done by 
Printing / Photocopying centres if you do not have a scanner.

3.    From Word etc.    If you have it as an object in Word or some other program, then try cutting and 
pasting it into Microsoft Paint, and then save it.

4.    From the Screen    If you can display it on the screen, but cannot cut and paste it into Microsoft Paint,
then display it on the screen, press `Alt Print Scrn` (to place a copy of the screen on the clip board), 
open Microsoft Paint, and select File Paste from the menu.    You should now see a copy of the entire 
screen you saved earlier on.    Now select the little rectangle on the toolbar, and select only the logo 
with the rectangle.    Press Ctrl C to place the logo on the clip board, select `File New` and paste it 
back on again.    When you have finished save the file.

The final .BMP file needs to have enough resolution to print out neatly, but should also not be too large, 
because printing will slow down, and backups will become unnecessarily large.    Typically the .BMP file 
would be 256 colours and around 100k to 300k in size.    Avoid using a BMP file over 300k because the 
database would take longer to backup.

After you have created your .BMP file, Open it with Microsoft Paint, select `File, Select All`, and then `File,
Copy`.    Then click on the existing logo in the Letterhead setup screen (it should become highlighted) and
press `Ctrl V` to paste it in.    Your logo should now appear instead of the old one.    You can resize it and 
position it to suit.

It is possible to cut and paste the logo from all sorts of applications, but it is strongly recommended that 
you only cut and paste from Microsoft Paint.    Cutting and pasting from other applications has caused 
intermittent problems, and also takes a lot longer to print, because it relies on that application to do the 
printing.



Statements
Batch Statements

To print out a statement for a particular customer, select that customer, and then click print or preview.

Please note that `Incomplete` invoices are not shown on a Statement.

Enabling the `Print payments made` box will print any part payments made for invoices, and will include 
all payments made in the last 35 days (ie. last month plus a few days grace).

Enabling the `Print payment slip as footer` will add a payment slip to the bottom of the statement.

You can adjust the Statement Date shown on the statements. (For example to show the last day of the 
month).

To alter the page setup for Statement printouts, select Print Setup from the File menu.



Batch Statements
Statements

If you want to send a statement to all your customers who have an amount outstanding, then enter 0 in 
the `Days Old` box.

If you want to only send statements to accounts which are more than a certain number of days old then 
enter that number in the `Days Old` box and print them out.

You can adjust the Statement Date shown on the statements. (For example to show the last day of the 
month).

Enabling the `Print payments made` box will print any part payments made for invoices, and will include 
all payments made in the last 35 days (ie. last month plus a few days grace).

Enabling the `Print payment slip` will add a payment slip to the bottom of the statement.

To alter the page setup for Statement printouts, select Print Setup from the File menu. 



Batch Invoicing
Invoicing

If you need to regularly invoice customers for subscriptions, monthly payments etc. then you should use 
Batch Invoicing.

Before using Batch Invoicing you must set up one or more initial invoices. After you have done this you 
may create a Batch - this is a group of invoices that you wish to repeat and regularly process together.

To Create a Batch:-
1.    Select an invoice that you wish to include in the Batch.
2.    Alter the description if you wish.
3.    Choose the print option required.    Here you can specify whether the invoices should be created as 

incomplete or outstanding and whether the invoices need to be printed.    Note: If you need to make 
additions or alterations to invoices before printing them choose Make Status Incomplete.

4.    Assign a batch number. All invoices with the same batch number will be processed together as one 
Batch.

To Process a Batch:-
1.    Select the Batch to Process.
2.    Specify the Invoice Date.
3.    Click on Process Batch.
This will create a new invoice based on each invoice in the Batch with the Invoice Date specified.
Please note that when the batch is processed the invoices created will become the templates for the next 
batch.



Invoice Column Options

If you are viewing these invoice options from an invoice then you will see the changes to the layout of the 
invoicing screen straight away.    To do this go into an invoice and click on the `Invoice Column Options` 
button.

The `Set As Default` button saves the current settings for new invoices created in the future.

1.    Display the Product Lookup Button    Displays a lookup button (Binoculars) on the left hand side of 
the details section.    You can click on it to find a particular product or service to invoice.    If you dont 
use product codes, or there are too many to remember, but you do want to be able to look them up, 
then turn this on.

2.    Display / Print the Codes Column    Displays a column which lets you select a product or service 
from a list.    If you can remember your product codes, then this lets you enter them very quickly by 
simply typing them in.

3.    Number of Lines for the Description    Each line item in the invoice normally only has one line for 
the description, but if you need more room for the description then you can increase the number of 
lines to display on the screen.    The invoice printout will always expand to display all the information 
typed in the description regardless of the number of lines displayed on the screen.

4.    Display the Cost Centre Column    If you need to allocate different items on an invoice to different 
cost centers, then check this item.    You can then create a report which calculates the sales by cost 
center.

5.    Display / Print the Quantity Column    This can be turned on or off depending on whether you want 
quantities displayed or not.

6.    Allow Formulas in Quantity Column    Some businesses need to enter quantities as formulas.    For 
example a pane of glass 1.234 X 0.456 can be entered in the quantity column, and m² can be entered 
in the units column, and $15 (the cost per square meter of glass) can be entered in the Unit Price 
column.

7.    Display / Print the Units Column    If you want to display units such as Hours, Kms, m², etc, then 
turn this on.

8.    Display the Cost Price Column    If you want to calculate the profit for each invoice then turn this on. 
You can create profit reports with the report writer.

9.    Display / Print the Discount Column    If you want to give your customer a discount then you can 
turn this on.

10. Line Item Prices Include GST    Some businesses want their invoices to show prices which are 
inclusive of GST.    To do that, turn this on.

11. Display GST Rate for Each Line    Some invoices have line items where some have GST and some 
don`t.    If the GST rate is not the same for all items on the invoice, then select this option.



Invoices Outstanding

This screen lists all outstanding invoices with the oldest one at the top.    Incomplete invoices are not 
shown.

You can type notes into the Follow Up Notes box to help you chase up that invoice.    You can double click
on it to make it bigger.

To sort by Company (ie. group all invoices for a company together) simply click anywhere in the Company
column, and then select Sort A-Z from the Edit menu.

The Detail Report prints out a report which is similar to the screen.    The Summary Report prints out an 
Aged Debtors report, where each company is only listed once.    A customisable version of the detailed 
report is available in the Report Writer.



Footer Text

The footer text is printed at the bottom of a Invoice, Statement, or Packing Slip.    You can put promotional 
information in the footer text or legal terms such as :-

Ownership of these goods do not pass to the purchaser until payment is made in full.

Please keep these invoices as proof of purchase for warranty purposes.

A late payment fee of 5% per month is applied to over due payments.



Back Orders

There is no way in Cashbook Complete of tracking Back Orders (items you can`t deliver because they 
are out of stock).    The recommended way of handeling back orders, is to create an invoice for the 
items you can deliver, print it out (with the packing slip if you want to).    Then create another invoice for
the items on back order, and leave it as an incomplete invoice, until you have enough stock.



Quick Keys

In many screens there are certain Quick Keys or ``Keyboard Shortcuts`` available (with corresponding
buttons in the screen header) to help speed up regular tasks that you are likely to perform.    Pressing 
a Quick Key has the same effect as clicking on the corresponding button in the header section of the 
form.

F1 =  Help
F5 =  Lookup    Lookup a record for the current screen from a list.

F8 =  Delete        Delete the current record.

F9 =  New              Add a New record.

F10 =  Close Close the current screen.



Administration

The following Administrative functions are available from the File menu :-

1.    Backup Cashbook    The practice of keeping regular backups of your cashbook is strongly 
recommended. To help you do this, Cashbook Complete will remind you periodically, but you can also 
select Backup Cashbook from the File menu.More information on Backups    

2.    Restore From Backup If you do need to do a Restore, select Restore from the File Menu.    It is 
recommended that you make another backup of your cashbook before restoring the old one (in case 
you change your mind, or the restored database is corrupt as well).

3.    Repair and Compact    If the database gives an error something like `The database is corrupt.    
Please Repair and Compact the Database`, then select it from the File menu.    The database can 
become corrupt if for example the power goes off while you are entering some data.    When you select
this item, the Cashbook and Projects are recalculated as well.    It would be a good idea to Repair and 
Compact the Database about once a month.

4.    Purge    (Delete Old Data)    You can purge old data to reduce the size of your database, you can 
select it from the File Menu.    To recover the disk space after the purge, you need to run Repair and 
Compact as well.



Year 2000
License Agreement 

Acclaim Software Ltd warrants that this product will :-

1.    Accurately process date-related data after 31st December 1999
2.    Allow four digit years to be displayed wherever a date is displayed
3.    Correctly process leap years, including the year 2000

This warranty is subject to the terms and conditions stated in the License Agreement.

It is recommended that the software be configured to display a 4 digit year (Select Setup Wizard from the 
File menu).    All dates from the 1st January 2000 onwards will be displayed with four digit years 
regardless of whether the date format is two digits or four digits.



Deleting Line Items

Select `Delete Line` from the `Edit` menu or :-

1. Click on the grey box to the left hand side of the line you want to delete. (as shown in the example 
below)
2. Press the Delete key on your keyboard. (or select Edit, Delete from the menu at the top of the screen)



Placing an Icon on your Desk Top

If you are using Windows 95 and wish to place an Icon to start this software on your desk top, the 
procedure is as follows :-

1. Click on Start button with your right mouse button.
2. Click on Open
3. Double Click on the Programs folder
4. Double Click on the Cashbook Complete folder
5. Click on the Cashbook Complete Icon and then press Ctrl C to place the icon on the clipboard
6. Close all programs down, click somewhere on the desktop, and press Ctrl V to paste the icon onto the 
desk top.



Setup & Administration

Backup, Restore, Repair, Compact, Purge
Placing an Icon on your desk top
Setup - Cashbook
Setup - Letterhead
Setup - Network
Setup Wizard
Year 2000



License Agreement

IMPORTANT :  Please read this License carefully before using the software.    The right to use this software is 
granted only if the customer agrees to the terms of this license.    If you do not agree to the terms of this License, you 
must not use the software, and must remove it from your computer.    However, use of this software indicates your 
complete and unconditional acceptance of these terms and conditions.    Acclaim Software Ltd grants you a 
license to use a copy of the software subject to the following terms and conditions.

1.    No title or ownership is conferred with this license.
2.    This license also applies to customised versions of the software.    For customised versions all intellectual rights 

remain with Acclaim Software.
3.    The Software may only be copied using the original installation disks or installation file.
4    You do not remove any copyright notices from any part of this software.
5    This software is copyrighted and may not be disassembled, de-compiled,    decrypted, or reverse engineered, or 

have its security tampered with.
6.    Any third party supplier of this software is a third party beneficiary of this license and may protect its rights against

violations in this license.
7.    Acclaim Software Ltd reserves the right to terminate this license upon breach.    In the event of termination of the 

License, all copies of the software must be returned or destroyed.
8.    Acclaim Software Ltd shall not be liable for lost profits, or for any incidental, special, or consequential damages 

caused by this software.
9.    You may not alter the software without the written consent of Acclaim Software Ltd.
10. This Agreement sets forth the entire agreement between the parties.
11. Acclaim will not be held liable to fix any problems caused by Microsofts operating systems or their database 

products, printer drivers, faxing software, word processing software, or any connections to other software.
12. Errors or omissions in the software will be fixed at Acclaims discretion.
13. Acclaim does not warrant or guarantee that the software will meet the licensees requirements.    The Licensee 

must check that the software meets their requirements before purchasing the software.    No refunds are given.
14. Prices and Support arrangements shown by the software or help file are updated from time to time.    The latest 

information on prices and support are on our web site (found by clicking on the Help menu and selecting About).
15. The Home edition is free, but you must register business cashbooks once you have determined that the software 

is suitable for that business.    Each business cashbook database is to be registered separately.
16. Acclaim reserves the right to restrict the functionality of the software for unregistered users, or for users who have

not registered the software to the appropriate level.
17. Free support is currently provided for up to 3 incidents for each registered cashbook.    After the 3 incidents have 

been used up, extra support needs to be purchased.    Callouts to the customers premises, or problems which 
take more than 30 minutes to resolve are charged out at Acclaims normal hourly rate.    Acclaim reserves the right 
to change phone support to an 1900 / 0900 number at any time in the future.

18. Free support for unregistered users is given at Acclaims discretion.
19. Free support is not to be used as a substitute to training or reading the manual or help files.
20. Support is given only in the English language, and is not given to people who do not have a basic understanding 

of how to operate their computer.
21. This License Agreement may change when the software is upgraded.    The Licensee must check and accept the 

new license agreement before upgrading.
22. Upgrading of customisations is charged at Acclaims normal hourly rate.
23. If there is a special promotion in a specific country, it is your responsibility to make sure that your Regional 

Settings in the Setup Wizard are set to your country, otherwise the special promotion will not apply.



Networking

This software can be installed on a network, and can be used by more than one person at a time.    By 
having it on a File Server, you could also take advantage of its regular backup.    To install it on a 
network :-

1.    Install the software on each computer as though it is going to work locally.
2.    Copy the <<Company Name>>.CB file to a directory on your file server.
3.    Select Open Cashbook from the File menu, and enter the directory where the cashbook(s) resides.

Please note that :-

1.    If you have an unreliable network your datafile may become corrupted.
2.    The Windows NT backup system does not back up files which are in use, so it is important that all 

users exit the system when a backup is being done.



Suggestions

If you have suggestions to make for this product, please send an email to support@acclaimsoftware.com



Support

Our latest support system and prices are shown on our internet web site (found by clicking on the Help 
menu and selecting About).



Reports Contents

Cashbook
Contact Management
Report Writer Contents



Registration - New Zealand

Cashbook Lite
With Cashbook Lite, you will be registering the :-

Cashbook
Contacts
Bills to Pay
Report Writer

You will be able to use the whole program on a trial basis, but may be asked to upgrade to Cashbook 
Complete later on.

Cashbook Complete
With Cashbook Complete, you will get all the modules and functionality of the program.

Upgrade Lite to Complete
With the Upgrade you will convert Cashbook Lite to Cashbook Complete.

Installation CD ROM
With the CD ROM you will be able to install the software on PCs which are not connected to the Internet.   
The software may be freely copied to as many PCs as you wish, so long as the software is registered 
once it has been evaluated as being suitable.    The CD ROM version is identical to the Internet version.    
You can make a set of Installation Floppy Disks from the CD ROM.

Instruction Manual
The Instruction Manual gives you thorough instructions on using the software in printed form.    It can also 
be viewed online from the Help menu.



Registration - Australia

Cashbook Lite
With Cashbook Lite, you will be registering the :-

Cashbook
Contacts
Bills to Pay
Report Writer

You will be able to use the whole program on a trial basis, but may be asked to upgrade to Cashbook 
Complete later on.

Cashbook Complete
With Cashbook Complete, you will get all the modules and functionality of the program.

Upgrade Lite to Complete
With the Upgrade you will convert Cashbook Lite to Cashbook Complete.



Registration

Cashbook Lite
With Cashbook Lite, you will be registering the :-

Cashbook
Contacts
Bills to Pay
Report Writer

You will be able to use the whole program on a trial basis, but may be asked to upgrade to Cashbook 
Complete later on.

Cashbook Complete
With Cashbook Complete, you will get all the modules and functionality of the program.

Upgrade Lite to Complete
With the Upgrade you will convert Cashbook Lite to Cashbook Complete.



Backup
Restore          Repair and Compact

The practice of keeping regular backups of your cashbook is strongly recommended.    To help you do 
this, Cashbook Complete will remind you periodically, but you can also select Backup from the File menu.
When the backup screen appears, it will tell you when your cashbook was last backed up, allow you to 
specify how often you wish to be reminded to do backups, and specify the directory on which the backup 
should be stored.

Backup to floppy disk
If you choose to backup to a floppy disk then use two or more disks and rotate them so that you will 
always have a current and a past backup.    For your security, backup files should be kept in a safe place 
away from your computer. Warning :- All data on floppy disk(s) that you insert for the backup will be 
deleted.
If your backup spans more than one floppy disk the files will be named <filename>.001, <filename>.002 
etc. These files can only be restored by using the Restore function of Cashbook Complete.

Backup to a file server
If you save your backup on a file server, your cashbook file will be copied directly.    Please make sure that
the server is regularly backed up.

Please note that the Word/Wordpad files created by the Quotes module are not backed up by this 
procedure, and need to be backed up separately if they are important documents.



Errors

Copy the error message to the clipboard (hold Ctrl key down and then press C) and paste it as a 
message in an email (hold Ctrl key down and then press V) addressed to support@acclaimsoftware.com

If you got a Runtime Error, please email us exactly what you were doing, the screen you were in, the data 
you typed in, etc.

This will help us to improve Cashbook Complete for the next time you upgrade.



Searching for Data

There are several ways of finding data :-

1.    Find    You can select Find from the Edit menu (or press Ctrl F) to do a search in the cashbook.
2.    Sort A - Z    You can sort a column in alphabetical order by selecting it from the Edit menu.
3.    Moving or resizing columns    You can resize a column by moving the mouse over the column header 

edge and then dragging it to the requred width.    You can change the column order by clicking on the 
column header and then dragging it to the new position.

4.    Report Writer    The report writer is a powerfull querying tool which will let you use wild cards (* or ?) 
and other criteria to find the information you want.



Date Format

It is important to that you have the correct Regional and Date Format settings on your computer.    For 
example in the United States, dates are entered as Month/Day/Year, but a lot of other countries use 
Day/Month/Year.

To check your settings click on Start, Settings, Control Panel, Regional Settings.    Check that you have 
the correct country selected.    Click on the Date tab and check that you have the correct Short Date Style 
setting.    Common Short Date Styles are :-

Australia - d/MM/yyyy
Canada - dd/MM/yyyy
Ireland - dd/MM/yyyy
New Zealand - d/MM/yyyy
South Africa - yyyy/MM/dd
United Kingdom - dd/MM/yyyy
United States - M/d/yyyy

For new settings to take effect, please exit and restart the cashbook.



Contact Management - Help Contents

The help topics available for Contact Management are :-

Overview
Importing
Mail Merge
People to Call
Reports



Contact Management - Overview
Reports          People to Call          Delete          Delete a Line          Add          Mail Merge

The contacts screen displays contact and employee information for your clients, suppliers and other 
contacts.    It also has contact management capabilities where you can enter a date when you need to call
a person back in the future.

How to Enter in an Individual Person or Couple
The contact management database is set up to enter many people for one company, but you may want to
enter a client with his home address and phone number, without any company information.    To do that, 
enter their Surname and First Name in the Client Field and enter their Name in the First Name / Surname 
fields.    For example you might enter ``Smith, John & Mary`` in the client field and enter ``John Smith`` 
and ``Mary Smith`` in the contacts list.

List Check Box
It is common for client databases to have many people who are in the database with whom you seldom 
do business, but whom you dont want to delete.    To cater for this there is a List check box on the main 
part of the form which allows you to select which clients you want listed on your Phone List and Address 
List reports.

Recall Date
If you want a particular person to display on the People to Call screen enter a Recall Date next to their 
name.

Zoom
You can Zoom into either the Main Notes field or the Employees Notes field by double clicking on it.



Contact Management - Reports
Reports Contents

Address List
The Address List Report is under the Contacts menu, and prints a simple address list for all your listed 
clients and suppliers.    You can also make your own Address List using the Report Writer.

Phone List
The Phone List Report is under the Contacts menu, and prints a simple phone list for all your listed clients
and suppliers.    You can also make your own Phone List using the Report Writer.



People to Call
Contact Management Overview

This screen is used to list all the people whom you need to ring today.    The Recall Dates must first be 
entered through the Contacts Screen.    It works by showing all the Contacts who have a Recall Date of 
Today or earlier.

Zoom
The Binoculars button on the left hand side of each record will bring up the Contacts screen for each 
record.

Recall Date
To remove a record from the People to Call list, delete the Recall Date or enter a Recall Date that relates 
to a date in the future.



Importing Contacts
Deleting a Line

The Import Contacts screen provides you with a way of importing your existing contacts (Clients, 
Suppliers, etc.).    The basic idea is to copy and paste all the data from your other program into the import 
screen, and then press the Import button.    You do not have to have data in all the columns.

Before importing bulk data, you may want to do a test import with only one line of data.

The general procedure for importing contacts is as follows :-

1.    Prepare your Contacts Data    If your contacts data is not in a windows program where you can copy
and paste columns of data (such as Microsoft Excel), then you need to get it into one of those 
programs first.

2.    Copy the Company Data    From your contacts data, select the column containing the company 
name (by clicking on the button/box at the top of the column - see example below), and copy it to the 
clip board (from the Edit menu).

3.    Paste the Company Data    On the Import Contacts screen, click on the Company button/box in at 
the top of the top of the screen (See example below), and paste the company details in (paste from the
Edit menu).

4.    Copy and Paste the Other Columns    Copy and Paste the other columns in a similar manner to 
steps 2 and 3.

5.    Check and modify the data    Check the data, and modify it accordingly.
6.    Ready to Import    Once all the data has been checked, click on the Import button to import your 

Contact data.

Selecting a column



Mail Merge

You can export all the contact details to Excel for a mail merge as follows :-

Open the Mail Merge report in the Report Writer
Select the fields you want to export
Click on the Spread Sheet view
Select all the records (Edit Menu), and copy them to the clip board
Paste them from the clip board into Excel.



Setup Wizard

You can run the setup Wizard from the File Menu.

To view help on the Setup Wizard, please go to the screen in question and press F1 or Help.



Setup Wizard - Company Name and File Name

The Company Name will appear on the main screen and at the top of many reports.

Cashbook Complete allows you to run cashbook`s for several companies.      Enter an eight character 
name which will be used for the file name.



Setup Wizard - Regional
Year 2000

If the country is incorrect, then it is strongly recommended that you exit the Cashbook and change the 
Regional Settings to the correct values before continuing.    To change the regional settings, click on Start,
Settings, Control Panel, Regional Settings.

Cashbook Complete is programmed to work differently for different countries, so it is important that you 
select your own Country (and State if applicable).

It is recommended that you set the date format to display four digit years by placing four y`s in the date 
format.    For example    d/m/yyyy

There may be a discrepancy between the date format displayed here, and the date format displayed in 
the control panel.



Setup Wizard - General

1.    Organisation Name    This name will appear on your main screen, letterhead and many reports.
2.    Check Disk Space on Startup    To prevent the database from getting corrupted due to your hard 

disk getting full it is recommended that the hard disk space is checked when the software starts.
3.    Financial Year End Date    This date will be used to remind you to do your Year End reports.
4.    Backup Directory    This is the directory where Backups and Restores are done to or from.
5.    Paper Size    The default paper size for reports etc.
6.    Initial Screen    This is the screen displayed when the software starts.    It can be set to either None 

(So that you will only see the toolbar and menus), Main Screen (shows a main switch panel) or 
Cashbook (if you only use the Cashbook).

7.    Current Date / Time    For accounting software it is important that the date is correct.
8.    Email Address    The Email address you want to use for support.
9.    Customisation    This is normally set to Standard.    If you select Farming, then you will have an extra 

column in the cashbook which lets you enter a quantity.    The Advanced button lets you set up more 
advanced for screen formating.

10. Internet Browser    This is the Internet Browser that will be used for the Online Instruction Manual.    
To select a different one, click on the Magnifying Glass and locate the browser you want to use.



Setup Wizard - Modules / Features

This screen lets you select the level of functionality you require.

Edition
Cashbook Home is similar to MS Money or Quicken, and is only for home users who do not need GST to 
be calculated.    It is an excellent tool for doing your home budgets.    Cashbook Lite can do GST Returns, 
and also includes the Contact Manager.    Cashbook Complete also includes Invoices, Statements, 
Projects, Timesheets, Expenses and Quotes.

Security
This allows a logon with a password and different privileges for different users.    This is only available to 
registered users.

Report Writer
This gives you the power to create your own reports, ad hoc queries, etc. and lets you export data to 
other programs.        This is only available to registered users.



Cashbook - GST Setup Wizard

1.    Sales Tax Type    Select the most appropriate Sales Tax Type from the Combo box.
2.    Sales Tax Name    This is automatically entered when the Sales Tax Type is selected.    This name is 

used on many screens and reports.    It is usually set to either VAT, GST or TAX, but can be over-ridden
with a new name of up to 3 characters.

3.    Default GST Rate    This will be used as the default for Invoicing and Cashbook Categories which 
have GST.

4.    GST Number If you are GST registered then enter your GST number here.    This item's name can 
also be changed by clicking on More.

5.    Price Lists Include GST    If you generally sell to other companies then your prices would normally 
exclude GST (ie. select No), but if you generally sell to the general public then the prices would 
normally include GST    (ie. select Yes).

6.    GST Return Type (New Zealand Only)    This lets you select the GST method you have chosen with 
the IRD.    It is recommended to use Payments Basis (Cash Basis) because it is the easiest and by far 
the most common method for small businesses.



Cashbook - Bank Account Setup Wizard
Deleting an Account

All the bank accounts set up here must belong to the same organisation.    If you want to set up accounts 
for different organisations then each one should be put in its own cashbook by selecting New Cashbook 
from the File menu.

For the opening balance choose a bank statement from which you want to start entering the cashbook 
data.

The most often used bank account should be entered first.



Setup Wizard - Invoicing

1.    Default GST Rate    This will be used as the default for Invoicing.
2.    Invoice Header    This will be displayed at the top of the invoice.    Common headers are `Invoice`, 

`Tax Invoice`, `Invoice / Statement`.
3.    Default Invoice Terms    This is the initial value used on your Invoices for the Terms and is printed at 

the bottom of each invoice.    You can over-ride these default terms for specific invoices if you wish.
4.    Next Invoice Number    This is the Invoice Number that will be given to the next invoice.    This 

counter is automatically incremented every time you generate a new invoice.
5.    GST Number    If you are GST Registered then enter your GST number here.    This item's name can 

also be changed by clicking on More.
6.    Display GST Number on Invoice    Do you want to display your GST number on your invoice ?
7.    Print Payment Slip on Invoice    Selecting Yes will print a payment slip on invoices.
8.    Print Payment Slip on Statement    Selecting Yes will print a payment slip on statements.
9.    Display Payments Made on Statement Selecting Yes will print the payments made so far for each 
Invoice.



Setup Wizard - Letterhead Name and Address

1.    Company Name    This name will appear on your main screen, letterhead and many reports.
2.    Address, Phone, Fax Mobile, etc.    Enter all your contact details that you want to appear on your 

letterhead for your invoices, statements, quotations, etc.



Setup Wizard - Security

With Cashbook Complete you can set up logon`s with different security privileges (Access Rights) for 
different users.    It is possible to lock yourself out of the system if you forget your user name or password,
or if you do not give yourself the privileges to modify your own privileges !

In this screen please set up at least two users who will have full access to all the modules, and write their 
User Names and Passwords Down.    If you do not know what the passwords are then simply re-enter 
them.

You can set the privileges up in more detail from Employees & Security Setup under the Time & Cost 
menu.



Setup Wizard - Time and Cost / Quotes

1.    Invoices are often generated from Timesheets & Expenses    This is the default value of the 
Invoice column in the Timesheets and Expenses data entry screen.    You can generate Invoices 
directly from your Timesheets and Expenses.    If you think that you will do this for most of your 
invoices, then select Yes.

2.    Default User    The default user for entering Timesheets and Expenses (Only displayed if Security is 
turned Off)

3.    Full Name    Enter the employees first and last names
4.    User Name    The User name that will be used to log on (Only used if Security is selected)
5.    Password    The Password that will be used to log on (Only used if Security is selected)
6.    Cost Rate    Wages per hour plus about 20 % to allow for holidays, overheads, etc
7.    Charge Rate    Normal hourly charge out rate



Setup Wizard - Importing Data

You can Import data into Cashbook Complete by clicking on the Import buttons, or Import them later by 
selecting Import from the Cashbook or Contacts menu.



Setup Wizard - Setup Complete

Now that you have finished setting up the cashbook you can click on Finish to start using the cashbook.




